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Learning Outcomes

After completing this unit, you should be able to:

1. Set up adirectory to run Cadence

2. Install the design files for the AMS 0.35um PDK
3. Run the Cadence Design Manager (ICFB)

4. Create a Cadence Project

5. Create a simple Cadence Cell View (Schematic)
6. Link to an external library in Cadence

7. Use the external blocks in your design
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Introduction

m The first thing we need to do is to create a directory
that has the correct setup and config files to run:

e A: Cadence
e B:the AMS PDK (Process Design Kit)

m Log onto a Unix Machine (hind) using NX Client or
Exceed

e See Instructions on:

° Ettpl://users.ecs.soton.ac.uk/bim/notes/cad/quides/beqin.
tm

m Create a new directory in your home directory
e /home/username/EDA/labl
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http://users.ecs.soton.ac.uk/bim/notes/cad/guides/begin.html
http://users.ecs.soton.ac.uk/bim/notes/cad/guides/begin.html

Set up the current working directory

m The first step is to set up the local working
directory for the AMS 0.35um process.

m open anew terminal and type the following:
tcsh
source /opt/esdcad/scripts/ams_v400_tcshrc
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un Cadence Design Manager

m This will bring up the Cadence Design Manager:

e Virtuoso® 6.1.6-64b - Log: /home/tz1gl2/CDS.log.1 N [=E3]
Eile Tools Options Help cadence
Brogram: B{#)SC0S5: wirtuoso wersion 6.1.6-64h 0570372013 14:44 (s9fnll78) 3
Hierarchy: JhomefesdoadsSsof tware fcadence /linuz/IC6A. 16, 005 tools. LnxB6 /dEfII/
Sub wersion: sub-version IC6.1. 6-64db. 101 (Gd-hit addresses)

Working Directory: hind. ecs. soton. ac. uk: home /t2lgl2 /6097 /zty_demo_new_cadence

COPYRIGHT @ 1992-2013 GADENGCE DESIGN SYSTEMS INC. ALL RIGHTS RESERVED.
@ 1992-2013 UNIX SYSTEMS Lahoratories THC
Reproduced with permission.

This Cadence Design Systems program and online documentation are
proprietary/confidential information =nd may be discloseds/sed only
as authorized in a license agreement controlling such wse and disclosure.

RESTRICTED RIGHTS MNOTICE (SHORT FORM)
Use//reproduction/disclosure is subject to restriction
set forth at FAR 1252 22V-19 or its equivalent.
FWARNING* enwviyclicStringToIndes: could not find warishle 'wirtualPinSizeType'
in tool[.partition] *layout’
*WARNING* envSetWal: Can't set the walue of warizble 'wirtualPinSizeType’'.
in tool[.partition] 'layout' - it has not heen registered.
*WARNING* envSetWal: Can't set the walue of warishle 'topologySoomafterPick',
in tool[. partition] 'layout' - it has not heen registered.
*WARNING* envsSetWal: Can't set the walue of wariszble 'snapToPinlcigin:.
in tool[. partition] 'layout' - it has not heen registered.
FWARNING* enviyclicStringToIndesx: could not find warisble 'gatherBusStyle'
in tooll.partition] ‘'lawout' »

B =

limouse L: B B

e i
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Create a new library

m Cadence works by creating multiple libraries in
separate directories

m Using the Tools Menu — select the Ilbrary manager

Library Manager: Directory ...Lgl2/6097/zty_demo_new_cadence

File Edit ¥iew Design hManager Help

__ Show Categories __ Show Files

Library Cell Views

|

CORELIB Wi - Lock
CORELIE_SE

GATES

GATES_GB

IOLIEC_3E_dhd
IOLIBC_ANA_SE_4h
IOLIEYS_dhd
1OLIB_3E_am
IOLIE_4hkd
JOLIE_AMA_3E_ahd
IOLIE_AM A_dhd
[EADFRAMES
Library1
PACKAGES
PRIMLIB
FRIMLIERF
SPIRALS_ Ak

TECH_C35ES
TECH_C35E4

UE_dths
ahdlLib
analogLib
avTech
siC v

il I
Messages
Log file is "fhomestz1 g1 2/6097 /2ty _demo_new_cadenceslibManager.log”. —

111 Il

[Lib: Library1 [Free: 2. 25T 4
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The Library Manager Explained

m The Library manager handles “libraries”, “cells”
and “views”

Library Manager: Directory ... 1gl2/6097/zty_demo_new_cadence

Eile Edit ¥iew Design kManager Help cadence
__ Show Categories __ Show Files

Library Cell View

[

CORELIE Wiew - Lock
CORELIE_3E .

GATES

GATES_3E

ICLIBC_3B_4mM
IOLIBC_AMA_SE_4m
ICLIEY 54k
ICLIB_3EB_4r
IDILIE_4 M
ICLIB_ANS_3B_4m
ICLIB_ANS_4m
LEADFRAMES
Library1
FaCZKAGES
FRIMLIE
FRIMLIERF
SRIRALS_4rd

TECH_C35B3
TECH_C35B4

5_fths
ahdILib
analoglib
avTech

hasic

Messages

Laog file is “‘homedtz] gl 2060972ty _demo_new_cadenceslibtanagerlog”.

[ ]

[Cib: Library? [Free: 225T 4
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The Library Manager Explained

m Libraries are the containers for all the design
elements. For example a sandard cell library may
contain all the gates available in the PDK

IJhrary anager: Directory ...1gl2/6097/zty_demo_new_cadence

jer Help cadence

CORELIE 1o Files

CORELIB_3E I Cell Views

GATES

GATES_3B Wiew - Lock
IOLIBC_3B_4m I

IOLIBC_AMA_FE_4k

IOLIBYS_4hd
IOLIE_3B_dhd
IDLIB_4M
IOLIE_AMA_SB_4bkd
IOLIE_AMA_4ba =
LEADFRAMES N
Libirary
PACKAGES
FRIMLIE
FRIMLIERF
SPIRALS_4h

TECH_C35BE3
TECH_C35B4

IS5 _Bths
ahdlLib
analoglik
avTech

basic | ty_demo_new_cadence/libhanager.log”.

[Cib: Library1 [Free: 225T g
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The Library Manager Explained

m Each element, such as a gate, in the library is called
a cell —an example might be an inverter gate.

Library Manager: Directory ...1gl2/6097/zty_demo_new_cadence Cell

File Edit ¥iew Design kManager Help cédence |N"-.-"|:||

__ Show Categories __ Show Files 1ML E 3
Library Cell View M2
CORELIE M| ML G0
CORELIB R Wiew -~ | Lock | Size [ | (kAL 3
CORELIB_SE IRALE 24 ahstract 21k

GATES . IRALE0 cmas_sch 29k |MU}{32
GATES_3B MUK 31 layout 21k ML T3
ICLIBC_3E_4h ML 52 maps 25k

IOLIBC_aMA_3E_4k IMLI 33 Swﬁbm 19k IRALL=AD
IOLIBWS_adl IMUX40 IhAL %4
IDLIB_3B_4k kAL 4

IDLIB_4k4 kAL 42 ML= AZ
IOLIB_AMa_3B_4rd

IOLIB_AMa_and = 1M1

LEADFRAMES — v IMW
Library1 MY S =

PaCkaGES IR INYZ
PRIMLIE INYE (M3 =
FRIFMLIBRF MY E

SPIRALS_4n IM%10 N4
TECH_C3563 IMY12 MW G
TECH_C35B4 IM*15

Us_gths JEA MY
ahdiLib JKS IMY10
analoglik JEC

avTech JEICE MW 2
basic R Blely bl IMY15
Messages jE-IS

Log file is "‘homesz1gl 2060972ty _demo_new_cadenceslibhanagerlog”. — JECT

) JECE
A1 _

— = JECP il

Lib: CORELIE |Free: 373.07G ¢
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The Library Manager Explained

m Finally, each cell has a set of different views such

as schematic, or layout, or a model

Library Manager: Directory ...1gl2/6097/zty_demo_new_cadence

File Edit ¥iew Design kManager Help cﬁden(e
__ Show Categories __ Show Files

Library Cell Views

CORELIB I

CORELIE [ Wiew -~ | Lock | Size |
CORELIB_SE . IRALE 24 abstract 21k
GATES 1ML S0 cmos_sch 29k
GATES_GB kAL layout 21k
IOLIBC_3B_4h MUK 2 msps 23k
IOLIBC_AMA_3B_4h IMUX 33 symbol 19k
IDLIBY 5_4hd kAL 40

IDLIB_3B_4k kAL 4

IDLIB_4k4 kAL 42

IOLIE_AMA_3E_4h

IDLIB_AM&_ard = 1M1

LEADFRAMES . MY 2

Library1 MY S

PaCkaGES IR

PRIMLIE IMYE

FRIMLIERF MY G

SPIRALS_4k IM*10

TECH_C35B3 1M1 2

TECH_C35B4 IM*15

Us_gths JEA

ahdlLib R

analoglLib JECT

avTech JEICE

hasic v JECP gl

Messages

Log file is "*homestz191 276097 /2ty _demo_new_cadencedlibkanagerlog”.

[ ]

[Lib: CORELIE [Free: 379.07G
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Libraries in Cadence

m The library definition in Cadence consists of two
parts:

e 1. The library NAME — what you see in the library
manager

e 2. The library DIRECTORY — what is actually there in the
file system

m DO NOT just copy the library around, as this does
not handle all the links properly.
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Create your first library

m To create new libraries, you can use the library
manager (LM) to create a new library from scratch

= Library Manager: Directo

Edit Miew Design Manager Help

{ Library.
= Open... Ctrl+ O Lell View...
Cpen (Bead-0nly)... Ctrl+R Category..
Cpen With... 1M1
M ZS
Load Defaults... . IMALL S 2
Save Defaults... [MALEECS0
[N 31
Open Shell Window...  Cirl+P IMALIS 2
ML 33
Exit (g IMALL A0
T TLT | — Ih A1 A
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Create your first library

m The library manager will default to your current
directory, and ask you for a library name:

e enter libraryl or something similar

e remember:
+ Follow UNIX rules
+ Don’t use spaces
+ Don’t start with a number

- New Library

Library

Mame Library1]

Directory 5_';;;]194%21g1ZIED9?fzty_demu_new_cadencefn =] £F

7 gefConstraints.gef
D inverter_for_layout.dny
[ invertar_far_layoutlag

3 5im [ invertar_far_layoutrsf

(I back_upl [ inverter_for_layout scy
Cddemo_startup [ inverter_for_layout.vir

CJjobs [ inverter_layout_02.sp

[] assura_techlib [ libkkanager.log

[ binc.rul [ libtanager log.cdslck
[ bind.rul~ [ like_amsich1_tcsh

[] casnd3av.gef [ pear.cmd
[ calview.cellmap [ pearld. 3% cmd

O cos.lib

[ compare.rul

File type: |Directories

Design Manager
® Use MOME
Use Mo Dk

__ Comprassion enabled

€  cppy  cancel
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Creating your first library

m When you create a library, you will be asked
whether you want to attach to a technology file

m \What does this mean?

m When you create a design, you are working with
either NO process, or a SPECIFIC process (this
Implies a certain number of layers, design rules,
models etc)

m In this case we are working with the AMS C35B4C3
process.

School of Electronics and Computer Science, University of Southampton, UK
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Creating your first library

m Choose “attach to an existing techfile”

E Technology File for New Library x|

Technology File for library “Library2"

You can: w Compile an ASCI technology file

w Reference existing technology libraries

[

&ttach to an existing technology library

« Do not need process information

\Cancelﬂ Help
m And choose TECH C35B4

= Attach Library to Technology Library E]

Mews Library Lihraryl

Technology Library LEANFR&AMES
TECH C35E3 1]

Us Bths
analoglib
awTech v

m wEancely Anply ) wHelp
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Creating your first library

m Congratulations!, You will now have your first
Cadence Library

School of Electronics and Computer Science, University of Southampton, UK

18



Creating your first cell view

m Now you have your first library, you can create your
first cell view.

m Start from the library manager and choose New Cell
View.

|| Library Manager: Directo

Edit Yiew Design Manager Help

Blewy Wi Library..

Qpen... T+ cell View..
Open (Bead-Only)..  Cirl+R Categary...
Dipen With...

Load Defaults...
Save Defaults... I

Open shell Window...  Ctrl+P ‘ ‘

Exit Cirl+ ¥
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Creating a cell view

m Notice the library defaults to the one you have just
created

m If you don’t have this selected, make sure that it is —
the standard libraries will be READ ONLY

m Notice the View Name — schematic

m The Tool pulldown should be Schematics XL

m Click OK = New Fil X
File
Library liarary1 |3
Cell test
Wigw schematic
Type schamatic B
Application
Open with Schematics XL n

__ Always use this application for this type of file

Library path file
shomebhi mydesigncadence ficélab/ods. 1ib

@I cancel hel

School of Electronics and Computer Science, University of Southampton, UK
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Creating a cell view

m When you create a new cell view, the Cadence

Desigh manager will open the correct editing tool —

In this case Schematic L (schematlc editor)
automat|ca||y YT T————

A= $ 0@ X O TG ¢ -7 v I X QE | LLS»E
Besic n%«@: oy A Iy oy T | B e B-
78 X
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Adding Components

® You can now add components to the schematic

m To add components (transistors, passives, sources
etc) you must use the Create -> Instance option

Schematic L Editing: LiH

Launch File Edit »iew EBEEIEN Check Options Migrate  Window

NE = e el

1 wire (narrow) W

& ~ &~ © e oo T
1 wire pwidey Shift+'w

2bt Wire Mame... L

| Mavigator fedll=)

5"’ Default Wire Stubs and Mames Space
Q et Expression...

Mame

= inverter “® Ein... F

Block... B
kapping Schematic..

Cellview [
Solder Dot

Mote [
Fatchoord. ..

Frobe 3
FAUltiSheeat. ..
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Adding Instances

m Whenever you add an instance you need to use the
same library structure (library, cell, view) idea as
when you created your own cells.

® You need to use the symbol view

m Luckily, Composer allows you to Browse for the
correct cell using the library manager

O Add Instance

Likrary

Brovse

W ien symbol

Mames

» Add Wire Stubs at:
~ all terminals & registered terminals only

array Riowes 1 Columns 1

42 Rotate Ak Sideways Ei Lpside Down
m _Cancel ;, Defaults ;| Help

5 School of Electronics and Computer Science, University of Southampton, UK
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Check and Save

m Don’t forget to check and save your schematic

m Once you have saved the schematic, you can close

It using File -> Close
P sen

Launch FEile Edit Yiew Create Check €

| Mavigator
T Default

Schematic L Editing: L

Launchgdit Wiew Create Check Options Migrate Windo

"l Lj l'; L Mew.

= Dpen..

Dpen Symbol

5l o
<| -
=

1
=

Y Defaull | | save (Schematic)

Q Save a Copy... Ctrl+5
Discard Edits (not needed)...

I inverl (& Check and Save Shift+

bake Read Only

Import Power Intent...
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Create a simple circuit

m Cadence provide a simple library of electronic
primitives such as voltage sources, resistors,
capacitors etc

m These can be constructed into circuits and
simulated, however they do not have the
Information to be physically fabricated

m We can use them to build a simple test circuit to
learn how the design software works

School of Electronics and Computer Science, University of Southampton, UK 25




Create a simple RC circuit
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Add a pulse voltage source

- Edit Object Properties
Apply To only current n instance n
Show _ system & user o CDF
. / \n al O g L I b ->VS O u rC e Browse Reset Instance Labels Digplay
Froperty Walue Display

. Library Mame analogLib Eﬁ_n
e Source type: pulse =

o DC VOItage:1 Wiew Mame symbal Pﬁ__n

Instance Mame  ¥0 o K
Z I . O Add Delete Madify
. ero Va ue' User Property haster Walue Local walue Display
Ivelgnore TRUE ot n
e One Value: 1
CDF Farameter Value Display
. . DC valtage 19 of K
e Period of waveform:20ns — v B

Freguency name 1 \off ﬂ

. PUISe Width: 10”8 Delay time 0= \oft n
Type of rising & falling edge | n off n

e Rise time: 100ps v o

Cne value 1¥ _'I'ff__n
Y Fal I ti me . 100 S Perind of wavefarm 20n = off
. p Rise time 100p s L - |
Fall time 100p = of B
Fulse width 10n = \aff n
Display small signal params L _'I'ff__n
Display temperature params L of |
Display noise parameters L 'Z'ff_n
Multiplier o B

@I  concel epply ) Defaults ) Previous | Mext . Help
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Reference to ground

m AnalogLib ->gnd

m No parameters

|- Add Instance
Libirary analogLib Erowse |
e ——
iZell gnd|

Wiew symbol
MHames

» Add Wire Stubs at:
— allterminals & registered terminals only

Array Rows 1 Columns 1

42 Rotate J ih 5|dewayi__ = Upside Duwn__

m Connects globally to ground
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Add resistors, inductor & capacitor

m AnalogLib->res
e resistance = 1 for series
e resistance = 1k for load

m AnalogLib->cap
e capacitance = 1n

School of Electronics and Computer Science, University of Southampton, UK
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Connect up

m Use Create -> Wire(narrow)
e this gives a connect function — wire up the circuit

m Add wire names
e Create -> Wire Name
e Label the input vin and the output vout

m Check and Save

5 School of Electronics and Computer Science, University of Southampton, UK

30



Simulate

m Click on Launch — ADE L

IMI File Edit Wiew Create Check o

ADE HL

ADE GHL
Layout xL
Layout GXL
Layout EAD
Schematics L
Schematics XL

Create Model (ShGE)
Bcell IDE
Plugins [

e O W %

|||,Elasi|:

P

-

=

e g Y (YsOUrCE)
, —L gnd!

ADE L (3) - Library?2 inverter schematic (=)(El(x]
Launch Session  Setup  Analyses Marables OQutputs  Simulation Besults Tools Help cadence
It &l =8 EdD
. . Analyses 7. x| =
Desgign Wariables =AC
Type | Enahble| Arguments el
Marme | Walue @
#
Outputs 7.8 x| @

Mame/Signal/Expr | ¥alue | Plot| Save|

Plot after simulation: Suto [

Save Options |

Platting made: \[Beplace

| Status: Ready | T=27 C | Simulator: specire J
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Simulate

m Click on Analyses Tab and choose tran analysis
and set Stop Time: 100ns as shown below

H ADE L (3) - Library2 inverter schematic ===
Launch  Session  Setup Mles Dutputs  Simulation  Results Tools Help cadence
i v ) = Choosing Analyses -- ADE L (3) x
I o g | A o _
' Delete Analysis & tran w tc w/ 3C « hoise
Design variahl Enahle fAnalyses
esign Variahles El
g : Type | Enable) w o = w sens o doematch o sth
Mame | Disahle
w pZ ] « envip s P55

s pac ~ psth . pnoise s

o [SP o Hpss o gpac — Gpnoise
o gpf — gpsp o hh « hbac
-~ hbnoise

Outputs Tranzient Analysis

MName/Sighal/Expr | ¥alue | Plo
Stop Time 1000

accuracy Defaults (errpreset)

» conservative _ moderate | liberal

— Transient Moise

. Plot after simulation; (Auta Plat

i _ Dynamic Parameter
9(11) | Chaose ... | Status: Ready

Enabled w Cptions...
ey

@D cancel | Defaults . Apply ) Help
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Simulate

m Select output to be plotted by clicking on:
Outputs Tab - To be Plotted — Select on Schematic

Then choose the wires: in and out in the schematic window

brary2 inverter schematic

aimulation  Results Tools Help

[5 Setup .
E Delete
— Import
Tl Excnnrt Arguments
fran E-p Conseryative
To Be Saved

To Be Plotted

aelect On Schematic
&dd Ta
Eemowe From

_
i p

Save all .

"
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Simulate

m Than click Netlist and Run Tap to simulate

ematic

ADE L (3) - Library2 inverter s

SEIES)

Launch Session  Sefup  Analyses Marables Outputs  Simulation EN Tools Help

cadence

Il bl i 8 dE
_ _ Analyses
Design Variables Type | Enahle| Arguments
Mame | Value | | | tran W 0 100n conservative
o il
Outputs L7

" MamesSignal/E=pr | Walue | Plot| Save| Save Options
i in | allw Wi
_E out W k= ally

B I ) M

b

= select on Schematic Outputs to Be Plot

Plot after simulation; Auto

Plotting mode: Feplace

3(11) | Metlist and Run

| Status: Selecting outputs to be plotted.. | T=27 C | Simulator: spectre J
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Simulate

® You should be able to see the simulation results
plotted = A -

12(16) | plot new graph subwindow: J'

B You can now close the simulation window and the
schematic view of your cell
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re-opening the schematic

m From the library manager, find your schematic cell
view

m Right Click on the selected cell view

m Choose the “Open” option

m Composer will open your schematic for editing

School of Electronics and Computer Science, University of Southampton, UK
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Learning Outcomes

After completing this unit, you should be able to:

1. Set up adirectory to run Cadence

2. Install the design files for the AMS 0.35um PDK
3. Run the Cadence Design Manager (ICFB)

4. Create a Cadence Project

5. Create a simple Cadence Cell View (Schematic)
6. Link to an external library in Cadence

7. Use the external blocks in your design

School of Electronics and Computer Science, University of Southampton, UK 37



How does Cadence Know about Libraries?

m Cadence uses a file called cds.lib to establish the
libraries

m It looks first in the current working directory, then
your home directory for this

m It also has a default cds.lib iIf none exists

m This is an ASCII file that has the library name and
actual location

m environmental variables are often used in these
path definitions to make them general and portable
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Which cds.lib file?

m |t is good practice to set up your working
directories with custom design kit settings AND
libraries

m Keeping projects separate makes administration
and management of files MUCH easier.

m Therefore, each project directory should have its
own cds.lib

School of Electronics and Computer Science, University of Southampton, UK

39



How can | reference someone else’s design?

m Given that the definition of a library is done using a
name and pathname, can we use this to reference
other libraries not in our design space?

e Yes, but remember that the technology MUST be
compatible

e This is how the design kits work — we simply reference
the libraries in the design kit location

e You may also not have edit rights — perhaps read only

m You need to know, therefore:
e The library NAME
e The library LOCATION
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An example

m Thereis an examples library which has the name
library labl

m [tisinthelocation /lhome/bh9/labl/library labl
m How can we link to that existing library?

m First load up the library manager and select :
e Edit->Library Path
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Edit Library Path

m Library Path Editor: ...7/zty_demo_new_cadence/cds.lib [NameSpace CDBA] (Not Locke:/=|[H|%

m Typein the library
name you need

m Then typeinthe
absolute path name
to the directory,
including the library

nameitself |
m Close the editor and

Eile Edit Yiew Design Manager Help cadence
Libraries

—_— Likrary Fath

1 analoglib $COSDIRACoIs/dlete/cdslib/aristranalogLib
qunctional $CDSDIRADols dfllfetc/odslib/anistfunctional
3 hasic $COSDIRA0Is/diletc/odslib/hasic
EUS_Bths $CDSDIRAnols dillfetcrodslib/sheets/US_Gths
5 ahdiLib $COSDIRACols/dil samplesiattistahdILib
E hmslib $CDEDIRAools dil samples/artisthmslib

7 TECH_C35B3 $ars_DIR/icds/HK_CE5/TECH_CE5B3

E FRIMLIE Fars_DIR/cds/HE_C35/PRIMLIE

g [OLIB_4m FarE_DIR/icds/HEK_C35A0LIE_4M

ﬁ IOLIBYS_4h FarE_DIR/icds/HE_C35A0LIEYS_4hd

ﬁ IOLIB_aMNA_4hd Fars_DIR/icds/HE_CE5A0LIB_AMNA_4M
E CORELIE $arE_DIR/cds/HE_CS35/CORELIB

E GATES FarE_DIR/cds/HEK_C3S/GATES

14 GATES_3B HamE_DIRfcds/HE_C3GATES_3E

E shalib $COSDIRAnolsdillfetcrodslib/anist'shalib
16 LEADFRAMES HamE_DIR/cds/HK_ALL/ALEADFRAMES

E A&_CELLS Fars_DIR/icds/HE_C35/a_CELLS

18 PACKAGES $aME_DIR/cds/HE_ALL/PACKAGES

E FRIMLIBRF $ar5_DIR/cds/HE_C35/PRIMLIBRF

20 CORELIE_3B
21 I0LIEB_ANA_3B_4M
22 IOLIBC_3B_4M

23 IOLIBC_ANA_3IB_4M
24 BORDERS

25 TECH_C35B4

26 IOLIB_3B_aM

27 SFIRALS_4M

28 avTech
24 Libraryl

3z library_lah1
33 Library3
4

save the cds.lib file

FarS_DIRfcds/HE_C35/CORELIE_SE
FarMS_DIR/cds/HE_CS5A0LIE_AMNA_SB_4M
FarMS_DIRfcds/HK_C35/0LIEC_3B_4mM
FarMS_DIRfcds/HE_CSS/A0LIBC_AMNA_SE_4M
Fams_DIRfcds/HE_ALL/BORDERS
FarS_DIRfcds/HK_C35/TECH_C35B4
FarS_DIRfcds/HK_C35/0LIE_3E_4m
$aME_DIR/cds/HK_C35/SPIRALS_4M
‘fhomedesdcadssoftwarescadencesdinu-rassuradl 0fools/assurafetciavtechiavTech
fhometz1gl /60972ty _demo_new_cadencesLibraryl
fhomedzlgl 276097 2ty _demo_new_cadencesLibrary2
fhomeftz1gl2/6097 /2ty _demo_new_cadence/libl
fhomedbh3sdab dibrary_labl

fhomedzlgl 276097 2ty _demo_new_cadencesLibrary3

Likirary library_lab1 is defined locally.
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New Library....

m Now the new

library is \
available in the

library manager

Library

likrary_labl

IQLIBC_AMA_IB_4h
[OLIBWa_ 4k
[(QLIB_3B_4hd
[QLIB_ah
[QLIB_AMA_SB_dhd
[QLIB_AMa_4h
LEADFRAKES
Libraryd
LibraryZ
Likirary3
PACKAGES
FRIMLIE
FRIMLIERF
SPIRALS_4hkd
TECH_C35B3
TECH_C35B4
Us_Gths

ahdlLik
analoglik
avTech

basic

tbimslib
cdsDefTechlib
functional

ik

library_lab1

shalib
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Summary

m You can now create and edit your own libraries

m You can see how to link and share other directories
Into your Cadence library manager

m In thelibrary labl library you will find a basic RC
circuit

\
<\o

School of Electronics and Computer Science, University of Southampton, UK 44



	Introduction to Cadence
	Learning Outcomes
	Learning Outcomes
	Introduction
	Set up the current working directory
	Run Cadence Design Manager
	Learning Outcomes
	Create a new library
	The Library Manager Explained
	The Library Manager Explained
	The Library Manager Explained
	The Library Manager Explained
	Libraries in Cadence
	Create your first library
	Create your first library
	Creating your first library
	Creating your first library
	Creating your first library
	Creating your first cell view
	Creating a cell view
	Creating a cell view
	Adding Components
	Adding Instances
	Check and Save
	Create a simple circuit
	Create a simple RC circuit
	Add a pulse voltage source
	Reference to ground
	Add resistors, inductor & capacitor
	Connect up
	Simulate
	Simulate
	Simulate
	Simulate 
	Simulate 
	re-opening the schematic
	Learning Outcomes
	How does Cadence Know about Libraries?
	Which cds.lib file?
	How can I reference someone else’s design?
	An example
	Edit Library Path
	New Library….
	Summary

